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 1 Explore an Access 
  2010 Database
In this chapter, you will learn how to
✔ Work in Access 2010.
✔ Understand database concepts.
✔ Explore tables.
✔ Explore forms.
✔ Explore queries.
✔ Explore reports.
✔ Preview and print Access objects.

Microsoft Access 2010 is part of Microsoft Office 2010, so the basic interface—such as 
the Quick Access Toolbar, the ribbon, the Backstage view, and dialog boxes—should be 
familiar if you have used other Office 2010 programs. However, Access has more dimen-
sions than many of those programs, so it might seem more complex until you become 
familiar with it.

Tip If you are upgrading from an earlier version of Access, you should review “Introducing 
Microsoft Access 2010” at the beginning of this book to learn about differences between 
earlier versions and Access 2010.

Throughout this book, you’ll be working with databases that contain information about 
the employees, products, suppliers, and customers of a fictional company. As you com-
plete the exercises in this book, you will develop an assortment of tables, forms, queries, 
and reports, which are called database objects. These objects can be used to enter, edit, and 
manipulate the information in a database in many ways.

In this chapter, you’ll explore the Access program window and learn about the concepts and 
structure of data storage in Access, including types of databases, types of database objects, 
and relationships between objects. You’ll look at objects in a working database, learning 
about interesting features of Access as well as functionality that you’ll explore in more depth 
in later chapters.
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4  Chapter 1 Explore an Access 2010 Database

Practice Files Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice file you’ll use to complete the 
exercises in this chapter is in the Chapter01 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Working in Access 2010
As with all programs in Office 2010, the most common way to start Access is from the Start 
menu displayed when you click the Start button at the left end of the Windows Taskbar. 
When you start Access without opening a database, the program window opens in the 
Backstage view, with the New page active. In the Backstage view, commands related to 
managing Access and Access databases (rather than their objects) are organized as buttons 
and pages, which you display by clicking the page tabs in the left pane. You can display the 
Backstage view at any time by clicking the colored File tab in the upper-left corner of the 
program window.

Clicking the File tab displays the Backstage view, where you can manage database files and  
customize the program.
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 Working in Access 2010  5

From the New page of the Backstage view, you can create a blank database; or you can 
create a new database based on a template that comes with Access, on a template down-
loaded from the Office.com Web site, or on a custom template saved on your computer 
or on your network. From the Backstage view, you can also open a database you worked 
in recently, or navigate to any database on your computer and open it.

When you create or open a database, it is displayed in the program window.

File tab Quick Access Toolbar

Status bar

Title bar Ribbon

Navigation pane

An Access database in the program window

Troubleshooting The appearance of buttons and groups on the ribbon changes depending 
on the width of the program window. For information about changing the appearance of 
the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the 
beginning of this book.
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6  Chapter 1 Explore an Access 2010 Database

The database interface is designed to closely reflect the way people generally work with 
a database or database object. For those of you who are not familiar with this interface, 
which was first introduced with Microsoft Office Access 2007, here is a quick survey of 
the program window elements:

● The title bar displays the name of the active database. The designation (Access 2007) 
after the database name indicates that the database is in the .accdb format introduced 
with Access 2007. At the left end of the title bar is the Access icon, which you click 
to display commands to move, size, and close the program window. The Minimize, 
Restore Down/Maximize, and Close buttons at the right end of the title bar serve 
the same functions as in all Windows programs.

See Also Windows 7 introduced many fun and efficient new window-management 
techniques. For information about ways to work with the Access program window on 
a Windows 7 computer, refer to Windows 7 Step by Step, by Joan Lambert Preppernau 
and Joyce Cox (Microsoft Press, 2009). 

● By default, the Quick Access Toolbar appears to the right of the Access icon at the 
left end of the title bar, and displays the Save, Undo, and Redo buttons. You can 
change the location of the Quick Access Toolbar and customize it to include any 
command that you use frequently.

Tip If you create and work with complicated databases, you might achieve greater 
efficiency if you add the commands you use frequently to the Quick Access Toolbar 
and display it below the ribbon, directly above the workspace. For information, see 
“Customizing the Quick Access Toolbar” in Chapter 13, “Customize Access.”

● Below the title bar is the ribbon. All the commands for working with your Access 
database content are available from this central location so that you can work  
efficiently with the program.

● Across the top of the ribbon is a set of tabs. Clicking the File tab displays the Backstage 
view. Clicking any other tab displays a set of related commands represented by buttons 
and lists. The Home tab is active by default.

Tip Don't be alarmed if your ribbon has tabs not shown in our screens. You might have 
installed programs that add their own tabs to the Access ribbon.

● On each tab, commands are organized into named groups. Depending on your 
screen resolution and the size of the program window, the commands in a group 
might be displayed as labeled buttons, as unlabeled icons, or as one or more large 
buttons that you click to display the commands within the group.
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● If a button label isn’t visible, you can display the command name and its keyboard 
shortcut (if it has one) in a ScreenTip by pointing to the button.

See Also For more information about keyboard shortcuts, see “Keyboard Shortcuts” at 
the end of this book.

Tip To control the display of ScreenTips, display the Backstage view, click Options to 
open the Access Options dialog box, and change settings in the User Interface Options 
area of the General page. You can also change the language of ScreenTip content on 
the Language page. For more information, see “Changing Default Program Options” in 
Chapter 13, “Customize Access.”

● Some buttons include an integrated or separate arrow. If a button and its arrow 
are integrated, clicking the button will display options for refining the action of 
the button. If the button and its arrow are separate, clicking the button will carry 
out the default action indicated by the button’s current icon. You can change the 
default action by clicking the arrow and then clicking the action you want.

● Related but less common commands are not represented as buttons in a group. 
Instead they are available in a dialog box or task pane, which you display by 
clicking the dialog box launcher located in the lower-right corner of the group.

● To the right of the ribbon tab names, below the Minimize/Maximize/Close buttons, 
is the Minimize The Ribbon button. Clicking this button hides the commands but 
leaves the tab names visible. You can then click any tab name to temporarily display 
its commands. Clicking anywhere other than the ribbon hides the commands again. 
When the full ribbon is temporarily visible, you can click the button at its right end, 
shaped like a pushpin, to make the display permanent. When the full ribbon is hidden, 
you can click the Expand The Ribbon button to permanently redisplay it.

Keyboard Shortcut Press Ctrl+F1 to minimize or expand the ribbon.

● Clicking the Access Help button at the right end of the ribbon displays the Access 
Help window, in which you can use standard techniques to find information.

Keyboard Shortcut Press F1 to display the Access Help window.

See Also For information about the Access Help system, see “Getting Help” at the 
beginning of this book.

● On the left side of the program window, the Navigation pane displays lists of data-
base objects. By default, it displays all the objects in the database by type of object, 
but you can filter the list by clicking the pane’s title bar and then clicking the cat-
egory or group of objects you want to display. You can collapse and expand the  
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8  Chapter 1 Explore an Access 2010 Database

groups in the list by clicking the chevrons in the section bars. If the Navigation pane 
is in your way, you can click the Shutter Bar Open/Close button in its upper-right 
corner to minimize it. To redisplay the Navigation pane, click the Shutter Bar 
Open/Close button again. You can drag the right border of the pane to the left  
or right to make it wider or narrower.

Keyboard Shortcut Press F11 to display or hide the Navigation pane.

● Across the bottom of the program window, the status bar displays information 
about the current database and provides access to certain program functions. 
You can control the contents of the status bar by right-clicking it to display the 
Customize Status Bar menu, on which you can click any item to display or hide it.

● At the right end of the status bar, the View Shortcuts toolbar provides buttons for 
quickly switching the view of the active database object.

The goal of all these interface features is to make working with a database as intuitive as 
possible. Commands for tasks you perform often are readily available, and even those 
you might use infrequently are easy to find.

In this exercise, you’ll take a tour of the command structure in the Access 2010 program 
window.

SET UP You need the GardenCompany01_start database located in your Chapter01 
practice file folder to complete this exercise, but don’t open it yet. Just follow the steps.

 1. On the Start menu, click All Programs, click Microsoft Office, and then click 
Microsoft Access 2010.

Access starts and displays the program window in the Backstage view. From this 
view, you manage your Access database files, but you don’t work with the content 
of databases. For example, you can create a database, but not a database object. 
We’ll talk about the tasks you can perform in the Backstage view in other chapters 
of this book.

 2. In the left pane of the Backstage view, click Open. Then in the Open dialog 
box, navigate to your Chapter01 practice file folder, and double-click the 
GardenCompany01_start database.

The database opens in the program window. A security warning appears below 
the ribbon.
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 3. In the security warning bar, click Enable Content.

Important Be sure to read the sidebar “Enabling Macros and Other Database Content” 
later in this chapter to learn about Access security options.

Let’s save the database so that you can explore it without fear of overwriting the 
original practice file.

 4. Click the File tab to display the Backstage view, click Save Database As, and then 
in the Save As dialog box, save the database in your Chapter01 practice file folder 
with the name GardenCompany01.

Tip In this book, we assume you will save files in your practice file folders, but you 
can save them wherever you want. When we refer to your practice file folders in the 
instructions, simply substitute the save location you chose.

In the program window, the title bar tells you that you can work with this database in 
Access 2007 as well as Access 2010. On the left, the Navigation pane displays a list of 
all the objects in this database. Spanning the top of the window, the ribbon includes 
five tabs: File, Home, Create, External Data, and Database Tools. The Home tab is 
active by default. Because no database object is currently open, none of the buttons 
on the Home tab are available.

Tip Databases created with Access 2010 use the file storage format introduced with 
Access 2007, and their files have the .accdb extension. You can open database files 
created in earlier versions of Access (which have an .mdb extension) in Access 2010. 
You can then either work with and save them in the old format or work with and save 
them in the new format. If you convert them, you can no longer open them in versions 
prior to Access 2007. For more information about the ACCDB format, search for accdb  
in Access Help.

 5. In the Navigation pane title bar, click All Access Objects, and then under Filter 
By Group in the menu, click Tables.

The Navigation pane now lists only the tables in the database.

 6. In the Navigation pane, under Tables, double-click Categories.

The Categories table opens on a tabbed page. Because a table is displayed,  
two Table Tools contextual tabs (Fields and Table) appear on the ribbon. These 
contextual tabs are displayed only when you are working with a table.
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10  Chapter 1 Explore an Access 2010 Database

Ribbon tab names

Record
navigation bar

Contextual tab names Group names

Filtered
Navigation pane

Table on
tabbed page

View Shortcuts
toolbar

The record navigation bar at the bottom of the table page tells you how many records the 
table contains and which one is active, and enables you to move among records.

Buttons representing commands related to working with database content are 
organized on the Home tab in six groups: Views, Clipboard, Sort & Filter, Records, 
Find, and Text Formatting. Only the buttons for commands that can be performed 
on the currently selected database object—in this case, a table—are active.
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 7. On the Home tab, click the Text Formatting dialog box launcher.

The Datasheet Formatting dialog box opens.

From this dialog box, you can access settings not available as buttons in the  
Text Formatting group, such as Gridline Color and Border And Line Styles.

 8. In the Datasheet Formatting dialog box, click Cancel.

 9. Click the Create tab.

Buttons representing commands related to creating database objects are orga-
nized on this tab in six groups: Templates, Tables, Queries, Forms, Reports, and 
Macros & Code.

The Create tab.
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12  Chapter 1 Explore an Access 2010 Database

 10. Double-click the Create tab.

Double-clicking the active tab hides the ribbon and provides more space for the 
current database object.

The ribbon is hidden.

 11. Click the External Data tab.

The ribbon temporarily drops down, with the External Data tab active. Buttons 
representing commands related to moving information between a database and 
other sources are organized on this tab in four groups: Import & Link, Export, 
Collect Data, and Web Linked Lists.

Clicking any tab—in this case, the External Data tab—displays the ribbon temporarily.

Tip To make the graphics in this book readable, we are working in a program window 
that is smaller than full-screen. As a result, the Collect Data and Web Linked Lists groups 
are represented in this graphic as buttons. For more information, see “Modifying the 
Display of the Ribbon” at the beginning of this book.
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 12. Click anywhere in the open table.

The ribbon disappears again.

 13. Double-click the Database Tools tab.

Double-clicking a tab permanently displays the ribbon and activates that tab. 
Buttons representing commands related to managing, analyzing, and ensuring  
data reliability are organized on the Database Tools tab in six groups: Tools, 
Macro, Relationships, Analyze, Move Data, and Add-Ins.

The Database Tools tab.

 14. To the right of the Categories table page tab, click the Close button to close the 
table without closing the database.

Clicking this button closes the active object.

 15. Click the File tab to display the Backstage view, and then click Close Database.

When you close a database without exiting Access, the New page of the Backstage 
view is displayed so that you can open another database or create a new one.

Note that if you don’t close the active database before opening another one, 
Access prompts you to save your changes and closes the active database for you. 
You cannot have two databases open simultaneously in a single instance of Access. 
If you want to have two databases open at the same time, you must start a new 
instance of Access.

Tip You can close Access entirely by clicking the Close button in the upper-right corner 
of the program window, or by clicking Exit in the Backstage view.

CLEAN UP Retain the GardenCompany01 database for use in later exercises.
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14  Chapter 1 Explore an Access 2010 Database

Enabling Macros and Other Database Content

Some databases contain Microsoft Visual Basic for Applications (VBA) macros that 
can run code on your computer. In most cases, the code is there to perform a 
database-related task, but hackers can also use macros to spread a virus to your 
computer.

When you open a database that is not stored in a trusted location or signed by a 
trusted publisher, Access displays a security warning below the ribbon.

The security warning.

While the security warning is displayed, the macros in the database are disabled. 
You can enable macros in three ways:

● By enabling the macros in the database for use in the current database session.

● By adding the database publisher to the list of trusted publishers. This option is 
available only if the publisher’s digital signature is attached to the database. 
Access will then automatically enable macro content in any database that is 
also signed by that publisher.

● By placing the database in a trusted location. Access automatically enables 
macro content in any database saved in that location. The trusted locations 
you specify within Access are not also trusted by other Office programs.

To enable macros for the current database session only:

● In the Security Warning area, click Enable Content.

To add the publisher of a digitally signed database to the trusted publishers list:

 1. In the Security Warning area, click Some Active Content Has Been Disabled. 
Click For More Details.
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 2. On the Information About <Database Name> page, click the Enable Content 
button, and then click Advanced Options.

 3. In the Microsoft Office Security Options dialog box, click Trust All From 
Publisher, and then click OK.

Note that the Trust All From Publisher option is available only if the database 
is digitally signed.

To add the location of a database to the trusted locations list:

 1. Display the Backstage view, and then click Options.

 2. In the left pane of the Access Options dialog box, click Trust Center, and then 
click Trust Center Settings.

 3. In the left pane of the Trust Center, click Trusted Locations.

 4. On the Trusted Locations page, click Add New Location.

 5. In the Microsoft Office Trusted Location dialog box, click Browse.

 6. In the Browse dialog box, browse to the folder containing the current database, 
and then click OK.

 7. In the Microsoft Office Trusted Location dialog box, select the Subfolders Of 
This Location Are Also Trusted check box if you want to do so, and then click 
OK in each of the open dialog boxes.

If you prefer, you can change the way Access handles macros in all databases:

 1. Display the Trust Center, and then in the left pane, click Macro Settings.

 2. Select the option for the way you want Access to handle macros:

❍ Disable All Macros Without Notification If a database contains macros, 
Access disables them and doesn’t display the security warning to give 
you the option of enabling them.

❍ Disable All Macros With Notification Access disables all macros and 
displays the security warning.

❍ Disable All Macros Except Digitally Signed Macros Access automati-
cally enables digitally signed macros.

❍ Enable All Macros Access enables all macros (not recommended).

 3. Click OK to close the Trust Center, and then click OK to close the Access 
Options dialog box.
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16  Chapter 1 Explore an Access 2010 Database

Understanding Database Concepts
Simple database programs, such as the Database component of Microsoft Works, can store 
information in only one table. These simple databases are often called flat file databases, or 
just flat databases. More complex database programs, such as Access, can store information 
in multiple related tables, thereby creating what are referred to as relational databases. If 
the information in a relational database is organized correctly, you can treat these multiple 
tables as a single storage area and pull information electronically from different tables in 
whatever order meets your needs.

A table is just one of the object types you work with in Access. Other object types include 
forms, queries, reports, macros, and modules.

Of all these object types, only one—the table—is used to store information. The rest 
are used to enter, manage, manipulate, analyze, retrieve, or display the information 
stored in a table—in other words, to make the information as accessible and therefore 
as useful as possible.

Over the years, Microsoft has put a lot of effort into making Access not only one of the 
most powerful consumer database programs available, but also one of the easiest to learn 
and use. Because Access is part of Office 2010, you can use many of the same techniques 
you use with Microsoft Word and Microsoft Excel. For example, you can use familiar 
commands, buttons, and keyboard shortcuts to open and edit the information in Access 
tables. And you can easily share information between Access and Word, Excel, or other 
Office programs.

In its most basic form, a database is the electronic equivalent of an organized list of infor-
mation. Typically, this information has a common subject or purpose, such as the list of 
employees shown in the following table.

ID Last name First name Title Hire date
1 Anderson Nancy Sales Rep May 1, 2003
2 Carpenter Chase Sales Manager Aug 14, 2001
3 Emanuel Michael Sales Rep Apr 1, 1999

4 Furse Karen Buyer May 3, 2004

This list is arranged in a table of columns and rows. Each column represents a field—a 
specific type of information about an employee: last name, first name, hire date, and so 
on. Each row represents a record—all the information about a specific employee.

9780735626928_book.indb   16 2/15/11   1:27 PM



 Exploring Tables  17

If a database did nothing more than store information in a table, it would be no more 
useful than a paper list. But because the database stores information in an electronic 
format, you can manipulate the information in powerful ways to extend its utility.

For example, suppose you want to find the phone number of a person who lives in your 
city. You can look up this information in the telephone book, because its information is 
organized for this purpose. If you want to find the phone number of someone who lives 
further away, you can go to the public library, which probably has a telephone book for 
each major city in the country. However, if you want to find the phone numbers of all the 
people in the country with your last name, or if you want to find the phone number of 
your grandmother’s neighbor, these printed phone books won’t do you much good, 
because they aren’t organized in a way that makes that information easy to find.

When the information published in a phone book is stored in a database, it takes up far less 
space, it costs less to reproduce and distribute, and, if the database is designed correctly, 
the information can be retrieved in many ways. The real power of a database isn’t in its 
ability to store information; it is in your ability to quickly retrieve exactly the information 
you want from the database.

Exploring Tables
Tables are the core database objects. Their purpose is to store information. The purpose 
of every other database object is to interact in some manner with one or more tables. An 
Access database can contain thousands of tables, and the number of records each table 
can contain is limited more by the space available on your hard disk than by anything else.

Tip For detailed information about Access specifications, such as the maximum size of a data-
base or the maximum number of records in a table, search for “Access 2010 specifications” 
(including the quotation marks) in Access help.

Every Access object has two or more views. For tables, the two most common views are 
Datasheet view, in which you can see and modify the table’s data, and Design view, in which 
you can see and modify the table’s structure. To open a table in Datasheet view, either 
double-click its name in the Navigation pane, or right-click its name and then click Open. 
To open a table in Design view, right-click its name and then click Design View. When a table 
is open in Datasheet view, clicking the View button in the Views group on the Home tab 
switches to Design view; when it is open in Design view, clicking the button switches to 
Datasheet view. To switch to either of the two remaining table views (PivotTable view or 
PivotChart view), you click the View arrow and then click the view you want in the list. You 
can also switch the view by clicking one of the buttons on the View Shortcuts toolbar in 
the lower-right corner of the program window.
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When you view a table in Datasheet view, you see the table’s data in columns (fields) 
and rows (records). The first row contains column headings (field names). In this format, 
the table is often simply referred to as a datasheet.

Field

Field names

Record

Field names, fields, and records in a table.

If two tables have one or more field names in common, you can embed the datasheet 
from one table in another. By using an embedded datasheet, called a subdatasheet, you 
can see the information in more than one table at the same time. For example, you might 
want to embed an Orders datasheet in a Customers table so that you can see the orders 
each customer has placed.

In this exercise, you’ll open existing database tables and explore the table structure in 
different views.

SET UP You need the GardenCompany01 database you worked with in the preceding 
exercise to complete this exercise. Open the GardenCompany01 database, ensure that 
tables are listed in the Navigation pane, and then follow the steps.

 1. In the Navigation pane, double-click Products. Then at the right end of the 
Navigation pane title bar, click the Shutter Bar Close button so that you can 
see more of the table’s fields.
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The Products table is displayed in Datasheet view.

Each row in this table contains information about a product and each column contains one 
field from each record.

 2. In the row of field names at the top of the table, point to the right border of the 
Product Name field name, and when the pointer changes to a double-headed 
arrow, double-click the border.

Access adjusts the width of the field to accommodate its longest entry. Notice 
that Product 1, Magic Lily, and Product 2, Autumn crocus, are assigned to the 
Bulbs category.

 3. Double-click the right border of the Category field name to adjust that field’s width.

Tip You can also resize a table column by pointing to the border and dragging it to the 
left or right.

 4. In the Navigation pane, click the Shutter Bar Open button, and then double-click 
Categories.

Tip From now on, open the Navigation pane whenever you need to work with a 
different object, but feel free to close it if you want to see more of the data.
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The Categories table opens on a new tabbed page in Datasheet view. The Categories 
page is active, but the Products page is still open and available if you need it.

 5. At the left end of the record for the Bulbs category, click the Expand button.

The Bulbs category expands to reveal a subdatasheet containing all the records 
from the Products table that are assigned to the Bulbs category. This is possible 
because a relationship has been established between the two tables.

Subdatasheet

You can display records from two related tables simultaneously.

See Also For information about relationships, see “Creating Relationships Between 
Tables” in Chapter 2, “Create Databases and Simple Tables.”

 6. To the left of the record for the Bulbs category, click the Collapse button to hide 
the subdatasheet.

 7. Click the Close button at the right end of the tab bar (not the Close button in the 
upper-right corner of the program window) to close the Categories table.

 8. Close the Products table, and when Access asks whether you want to save your 
changes to this table, click Yes.
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In steps 2 and 3, you changed the look of the table by changing the widths of 
columns. If you want those changes to be in effect the next time you open the 
table, you must save them.

 9. In the Navigation pane, double-click the Orders table.

This table contains order-fulfillment information.

The record navigation bar at the bottom of the window indicates that this table contains 87 
records, and that the active record is number 1 of 87.

 10. On the record navigation bar, click the Next Record button several times.

The selection moves down the OrderID field, because that field is active.

Keyboard Shortcut Press the Up Arrow or Down Arrow key to move the selection 
one record at a time. Press the Page Up or Page Down key to move one screen at 
a time. Press Ctrl+Home or Ctrl+End move the selection to the first or last field in the 
table.

 11. Click the record navigation bar, select the current record number, type 40, and 
then press the Enter key.

The selection moves directly to record 40.

 12. On the View Shortcuts toolbar, click the Design View button.
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The Orders table structure is displayed in Design view, and the Table Tools Design 
contextual tab appears on the ribbon.

Datasheet view displays the data stored in the table, whereas Design view displays the  
underlying table structure.

See Also For information about table structure, see “Refining Table Structure” in 
Chapter 2, “Create Databases and Simple Tables.”

CLEAN UP Close the Orders table. Retain the GardenCompany01 database for use in 
later exercises.

Tabbed Pages vs. Overlapping Windows

By default, Access 2010 displays database objects on tabbed pages in the program 
window. If you prefer to display each object in a separate window rather than on a 
separate page, you can do so.

To switch to overlapping windows:

 1. Click the File tab to display the Backstage view, and then click Options.

The Access Options dialog box opens. 
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 2. Display the Current Database page, and then in the Application Options area, 
under Document Window Options, click Overlapping Windows.

 3. Click OK.

A message tells you that you must close and reopen the current database to 
put this change into effect.

 4. Click OK. Then close and reopen the database.

When database objects are displayed on tabbed pages, a Close button appears at the 
right end of the tab bar. When objects are displayed in overlapping windows, the win-
dow of each object has its own set of Minimize, Restore Down/Maximize, and Close 
buttons at the right end of its title bar.

Two forms displayed in overlapping windows.

You can move object windows by dragging their title bars, and you can size them 
by dragging their frames. You can also arrange windows by using the options avail-
able when you click the Switch Windows button in the Window group. (This group 
is added to the Home tab when you select Overlapping Windows in the Access 
Options dialog box.)
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Exploring Forms
Access tables are dense lists of raw information. Working directly with tables in a database 
you create for your own use might be quite simple for you, but it might be overwhelming 
for people who don’t know much about databases. To make it easier to enter, display, and 
print information, you can design forms.

A form acts as a friendly interface for a table. Through a form, you can display and 
edit the records of the underlying table, or create new records. Most forms provide an 
interface to only one table, but if you want to use one form to interact with multiple 
tables that are related through one or more common fields, you can embed subforms 
within a main form.

Forms are essentially collections of controls that either accept information or display infor-
mation. You can create forms by using a wizard, or you can create them from scratch by 
manually selecting and placing the controls. Access provides the types of controls that 
are standard in Windows dialog boxes, such as labels, text boxes, option buttons, and 
check boxes. With a little ingenuity, you can create forms that look and work much like 
the dialog boxes in all Windows programs.

As with tables, you can display forms in several views. The following are the three most 
common views:

● Form A view in which you display and enter data.

● Layout A view in which you can work with the elements of the form to refine the way 
it looks and behaves while also being able to see the data from the underlying table.

● Design A view that gives you more precise control over the look, placement, and 
behavior of elements of the form but that hides the underlying data.

See Also For more information about forms, see Chapter 3, “Create Simple Forms,” and 
Chapter 7, “Create Custom Forms.”

In this exercise, you’ll explore forms, subforms, and the available form controls.

SET UP You need the GardenCompany01 database you worked with in the preceding 
exercise to complete this exercise. Open the GardenCompany01 database, and then 
follow the steps.

 1. In the Navigation pane, click the title bar to display the category list, and then 
under Filter By Group, click Forms.

This group includes all the forms that have been saved as part of this database.

 2. In the Navigation pane, double-click Products.
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The Products form opens on a tabbed page.

This form is the interface for the Products table.

 3. Click the arrow adjacent to the Supplier box.

Access displays a list of all the company’s suppliers.

This is an example of a list box control.
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 4. In the Navigation pane, double-click Categories.

The Categories form opens on its own tabbed page. This form includes a main form 
and a subform. The main form displays information from the Categories table, and 
the subform, which looks like a datasheet, displays information for the current record 
from the Products table.

Subform

This form is the interface for the Categories and Products tables.

 5. On the record navigation bar, click the Next Record button a few times to display 
the next few records.

Notice that the subform changes with each click to display the products in each 
category.
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 6. In the Navigation pane, double-click Customers.

The Customers form opens in Form view.

The purpose of this form is to edit or create customer records.

 7. On the Home tab, in the Views group, click the View button.

For forms, clicking the View button switches between Form view and Layout view.

 8. In the Views group, click the View arrow, and then click Design View.

Access displays the Customers form in Design view, and adds three Form Design 
Tools contextual tabs (Design, Arrange, and Format) to the ribbon. The contextual 
tabs are available only when you are working on the design of the form in either 
Layout view or Design view.
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In this view, you can add controls to a form.

 9. Switch between Form view, Layout view, and Design view, noticing the differences 
in the program window.

 10. On the Design contextual tab, in the Controls group, display the Controls gallery.

Depending on the size of your program window, you might have to click the 
Controls button or the More button to display this gallery.

You can use these controls to assemble custom forms for your database.
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See Also For information about form controls, see “Adding Controls” in Chapter 7, 
“Create Custom Forms.”

 11. Click away from the gallery to close it.

 12. Right-click the tab of the Customers form, and then click Close All.

All the open database objects close.

CLEAN UP Retain the GardenCompany01 database for use in later exercises.

Exploring Queries
You can locate specific information stored in a table, or in multiple tables, by creating 
a query that specifies the criteria you want to match. Queries can be quite simple. For 
example, you might want a list of all products in a specific category that cost less than 
$10. Queries can also be quite complex. For example, you might want to locate all out-
of-state customers who have purchased gloves within the last three months. For the first 
example, you might be able to sort and filter the data in the Products table fairly quickly 
to come up with a list. For the second example, sorting and filtering would be very tedious. 
It would be far simpler to create a query that extracts all records in the Customers table 
with billing addresses that are not in your state and whose customer IDs map to records 
that appear in the Orders table within the last three months and that include item IDs 
mapping to records classified as gloves in the Products table.

You can create queries by using a Query wizard, and you can also create them from scratch. 
The most common type is the select query, which extracts matching records from one or 
more tables. Less common are queries that perform specific types of actions.

Processing a query, commonly referred to as running a query or querying the database, 
displays a datasheet containing the records that match your search criteria. You can use the 
query results as the basis for further analysis, create other Access objects (such as reports) 
from the results, or export the results in another format, such as an Excel spreadsheet.

If you create a query that you are likely to want to run more than once, you can save it. It 
then becomes part of the database and appears in the list when you display the Queries 
group in the Navigation pane. To run the query at any time, you simply double-click it 
in the Navigation pane. Each time you run the query, Access evaluates the records in the 
specified table or tables and displays the current subset of records that match the criteria 
defined in the query.
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Don’t worry if this all sounds a bit complicated at the moment. When you approach 
queries logically, they soon begin to make perfect sense.

See Also For more information about queries, see Chapter 8, “Create Queries.”

In this exercise, you’ll explore two existing queries.

SET UP You need the GardenCompany01 database you worked with in the preceding 
exercise to complete this exercise. Open the GardenCompany01 database, and then 
follow the steps.

 1. In the Navigation pane, display the Queries group.

The group includes all the queries that have been saved as part of this database.

 2. In the Navigation pane, right-click the Delete Discontinued Products query, 
and then click Object Properties.

Access displays the properties of the query, including a description of its 
purpose.

The icon at the top of the General tab indicates that this is a select query.
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 3. In the Delete Discontinued Products Properties dialog box, click Cancel.

 4. Right-click the Products By Category query, and then click Open.

Access runs the query.

This datasheet displays the results of running the Products By Category query.

The record navigation bar indicates that 171 records are displayed; the Products 
table actually contains 189 records. To find out why 18 of the records are missing, 
you need to look at this query in Design view.

 5. On the View Shortcuts toolbar, click the Design View button.

Access displays the query in the Query Designer, and the Query Tools Design 
contextual tab appears on the ribbon.
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The Query Designer.

Two boxes in the top pane of the Query Designer list the fields in the tables this 
query is designed to work with. The line between the boxes indicates that before 
the query was created, a relationship was established between the two tables 
based on the fact that the CategoryID field is present in both of them. The rela-
tionship enables this query to draw information from both tables.

See Also For more information about relationships, see “Creating Relationships 
Between Tables” in Chapter 2, “Create Databases and Simple Tables.”

The query is defined in the design grid in the bottom pane of the Query Designer. 
Each column of the grid refers to one field from one of the tables above. Notice 
that <> Yes (not equal to Yes) is entered in the Criteria row for the Discontinued 
field. This query finds all the records that don’t have a value of Yes in that field (in 
other words, all the records that have not been discontinued).

 6. As an experiment, in the Criteria row of the Discontinued field, replace <> with =. 
Then on the Design contextual tab, in the Results group, click the Run button.

Tip You can also run a query by switching to Datasheet view.

This time, the query finds all the records that have been discontinued. The 18 dis-
continued products account for the difference between the number of records in 
the Products table and the number of records displayed by the original query.
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The new query results.

 7. Close the Products By Category query. When a message asks whether you want 
to save your changes to the query, click No.

CLEAN UP Retain the GardenCompany01 database for use in later exercises.

Exploring Reports
You can display the information recorded in your tables in nicely formatted, easily accessible 
reports, either on your computer screen or on paper. A report can include items of informa-
tion selected from multiple tables and queries, values calculated from information in the 
database, and formatting elements such as headers, footers, titles, and headings.

You can look at reports in four views: 

● Report view In this view, you can scroll through the information in the report without 
being distracted by the page breaks that will be inserted when it is printed.

● Print Preview In this view, you see your report exactly as it will look when printed.

● Layout view This view displays the data in the report (similar to Print Preview) but 
enables you to edit the layout.

● Design view In this view, you can manipulate the design of a report in the same 
way that you manipulate a form.

9780735626928_book.indb   33 2/15/11   1:27 PM



34  Chapter 1 Explore an Access 2010 Database

See Also For more information about reports, see Chapter 5, “Create Simple Reports,” and 
Chapter 9, “Create Custom Reports.”

In this exercise, you’ll preview a report as it will appear when printed. You’ll also examine 
another report in Design view.

SET UP You need the GardenCompany01 database you worked with in the preceding 
exercise to complete this exercise. Open the GardenCompany01 database, and then 
follow the steps.

 1. In the Navigation pane, display the Reports group.

The group includes all the reports that have been created and saved as part of this 
database.

 2. In the Navigation pane, right-click Customer Labels, and then click Print 
Preview.

Troubleshooting If a message tells you that some data may not be displayed because 
of column widths and spacing, for the purposes of this exercise, simply press OK to 
continue.

The Customer Labels report opens, displaying a full page of labels in a view that is 
much like Print Preview in other Office programs. The ribbon now displays only the 
Print Preview tab.

Tip Access provides a wizard that can help you create a mailing label report. You can 
also create labels like these by using the Customers table as a data source for the Word 
2010 mail merge tool.

 3. Move the pointer over the report, where it changes to a magnifying glass. Then 
with the pointer over the middle label at the top of the report, click the mouse 
button.

The zoom percentage changes to 100%, as indicated on the Zoom Level button 
in the lower-right corner of the window. You can click this button to switch back 
and forth between the current and previous zoom levels.
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This report prints customer names and addresses in a mailing label format.

If the report is too small to read in Print Preview, you can adjust the zoom percent-
age by clicking the Zoom In button (the plus sign) at the right end of the Zoom 
slider in the lower-right corner of the window, or by dragging the Zoom slider. 
You can also click the Zoom arrow in the Zoom group on the Print Preview tab 
and then click a specific percentage.

 4. In the Navigation pane, right-click the Sales By Category report, and then click 
Print Preview.
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 5. Use any method to zoom the page to 100 percent.

 6. On the page navigation bar in the lower-left corner of the page, click the Last 
Page button.

This report generates nine pages of information by combining data from the 
Categories table and the Products table.

The magnified Sales By Category report.

 7. Click the Previous Page button a few times to view a few more pages of the 
report.

 8. On the View Shortcuts toolbar, click the Design View button.
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Access switches to Design view and displays four Report Design Tools contextual tabs 
(Design, Arrange, Format, and Page Setup) on the ribbon. In this view, the report 
looks similar to a form.

You create reports by using the same techniques you use to create forms.

CLEAN UP Close the open reports. Retain the GardenCompany01 database for use in 
the last exercise.
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Previewing and Printing Access Objects
Because Access is a Windows application, it interacts with your printer through standard 
Windows dialog boxes and drivers. This means that any printer that you can use from 
other programs can be used from Access, and any special features of that printer, such 
as color printing or duplex printing, are available in Access.

The commands for printing database objects are available from the Print page of the 
Backstage view. From this page, you can do the following:

● Print the active object with the default settings.

● Display the Print dialog box, where you can select the printer you want to use, 
as well as adjust various other settings appropriate to the active object and the 
current view.

● Display the active object in Print Preview.

In this exercise, you’ll explore the printing options for a table and a form.

SET UP You need the GardenCompany01 database you worked with in the preceding 
exercise to complete this exercise. Open the GardenCompany01 database, and then 
follow the steps.

 1. In the Navigation pane, display the All Access Objects category.

 2. In the Tables group, double-click the Employees table to open it in Datasheet 
view.

This table contains information about nine employees. Some of the columns are  
too narrow to display all their data, and even with the program window maximized, 
depending on your screen resolution, some of the fields might not fit on the screen.

 3. Adjust the widths of all the columns so that all the values in the fields are visible.

Access will not print data that is not visible.

 4. Click the File tab to display the Backstage view.
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 5. In the left pane, click Print.

The Print page displays the available print options.

The Print page of the Backstage view.

 6. In the right pane, click Print Preview.

The first page of the Employees table is displayed in Print Preview.

Tip This is the only way to preview a table, a query results datasheet, or a form. 
There is no Print Preview command available when you right-click one of these 
objects, and there is no Print Preview button on the View Shortcuts toolbar or in 
the View button list, as there is for reports.
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The Employees table in the default Portrait orientation.

 7. On the navigation bar at the bottom of the window, click the Next Page button. 
Then click the First Page button to move back to page 1.

If you print this datasheet with the current settings, it will print as two short, 
vertically oriented pages.

 8. On the Print Preview tab, in the Page Layout group, click the Landscape button. 
Then click the Next Page button.

In Landscape orientation, the datasheet still fits on two pages, with only one field 
on the second page.

 9. In the Page Size group, click the Margins button, and then click Narrow.

On the page navigation bar, the buttons are now gray, indicating that the 
Employee list fits on one page.

Tip You can set custom margins by clicking the Page Setup button in the Page 
Layout group and then adjusting the Top, Bottom, Left, and Right settings on the 
Print Options page of the Page Setup dialog box.
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The Employees table in Landscape orientation with narrow margins.

 10. In the Print group, click the Print button.

The Print dialog box opens.

In this dialog box, you can select the printer and set print options such as the pages  
or records to print, and the number of copies.
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 11. Click Cancel to close the Print dialog box, and then in the Close Preview group, click 
the Close Print Preview button.

 12. In the Navigation pane, under Reports, double-click Alphabetical List of 
Products.

The report opens in Report view.

 13. Display the Backstage view, click Print, and then click Print Preview.

Access displays a preview of the information that will be printed. 

 14. On the Print Preview tab, in the Zoom group, click the Two Pages button.

Access displays the first two pages in the report side by side.

You can preview more than one page at a time.

 15. On the View Shortcuts toolbar, click the Report View button to return to 
that view.

CLEAN UP Save your changes to the Employees table, and close both the table and 
the report. Then close the GardenCompany01 database.
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Key Points
● The basic Access interface objects work much the same as in other Office or 

Windows programs.

● A database is the computer equivalent of an organized list of information. 

● Tables are the core database objects. Access data is organized in tables made up 
of columns and rows, called fields and records.

● In a relational database, tables can be related based on common fields, enabling 
the retrieval of information from more than one table at the same time.

● The purpose of the other database objects—forms, reports, queries, macros, and 
modules—is to interact with one or more tables.

● Every Access object has two or more views. For example, you view data in a table 
in Datasheet view and define how the data is structured in Design view.

● If you want to print a database object, be sure the information you need is visible 
on the screen before you print.
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 2 Create Databases 
  and Simple Tables
In this chapter, you will learn how to
✔ Create databases from templates.
✔ Create databases and tables manually.
✔ Manipulate table columns and rows.
✔ Refine table structure.
✔ Create relationships between tables.

Creating the container for a database is easy. But an empty database is no more useful  
than an empty document or worksheet. It is only when you fill a database with data in 
tables (known as populating a database) that it starts to serve a purpose. As you add 
forms, queries, and reports, it becomes a useful tool. If you customize it by adding a 
startup page and organizing the various objects into categories and groups, it moves 
into the realm of being a database application.

Not every database has to be refined to the point that it can be classified as an application. 
Databases that only you or a few experienced database users will work with can remain 
fairly simple. But if you expect someone without database knowledge to enter data or 
generate their own reports, spending a little extra time in the beginning to create a solid 
foundation will save a lot of work later. Otherwise, you’ll find yourself continually repairing 
damaged files or walking people through seemingly easy tasks.

Microsoft Access 2010 takes a lot of the difficult and mundane work out of creating and 
customizing a database by providing database applications in the form of templates that 
you modify and populate with your own information. Access 2010 also provides templates 
for common elements that you might want to plug into a database. These application 
parts consist of sets of objects—a table and related forms, queries, or reports—that 
together provide a complete, functioning part of a database. All you have to do is fill in 
your data. If none of the templates meet your needs, you can create tables manually.

9780735626928_book.indb   45 2/15/11   1:28 PM



46  Chapter 2 Create Databases and Simple Tables

In this chapter, you’ll create a database from a template and create a table manually. 
Then you’ll adjust the display of a data table to fit your needs. By the end of this chapter, 
you’ll have a database containing a few tables and you’ll understand a bit about how 
the tables in the databases you will use for the exercises in the remaining chapters of the 
book were created.

Practice Files You don’t need any practice files to complete the exercises in this chapter. 
For more information about practice file requirements, see “Using the Practice Files” at 
the beginning of this book.

Creating Databases from Templates
A few years ago (the distant past, in computer time), creating a database structure involved 
first analyzing your needs and then laying out the database design on paper. You would 
decide what information you needed to track and how to store it in the database. Creating 
the database structure could be a lot of work, and after you created it and entered data, 
making changes could be difficult. Templates have changed this process, and committing 
yourself to a particular database structure is no longer the big decision it once was.

A template is a pattern that you use to create a specific type of database. Access 2010 
comes with templates for several databases typically used in business and education, and 
when you are connected to the Internet, many more are available from the Microsoft 
Office Online Web site at office.microsoft.com. By using pre-packaged templates, you 
can create a database application in far less time than it used to take to sketch the  
design on paper, because someone has already done the design work for you. 

Using an Access template might not produce exactly the database application you want, 
but it can quickly create something that you can customize to fit your needs. However, you 
can customize a database only if you know how to manipulate its basic building blocks: 
tables, forms, queries, and reports. Due to the complexity of these templates, you probably 
shouldn’t try to modify them until you’re comfortable working with database objects in 
Design view and Layout view. By the time you finish this book, you will know enough to be 
able to confidently work with the sophisticated pre-packaged application templates that 
come with Access.

In this exercise, you’ll create a database application based on the Tasks template. This 
template is typical of those provided with Microsoft Access 2010, in that it looks nice 
and demonstrates a lot of the neat things you can do in a database.
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SET UP You don’t need any practice files to complete this exercise. Close any open 
databases, and then with the New page of the Backstage view displayed, follow  
the steps.

 1. In the Available Templates area, click Sample Templates.

Access displays a list of the templates that shipped with the program and are  
installed on your computer.

 2. Click the Tasks template icon.

In the right pane, you can assign a name to the database and browse to the location 
where you want to store the database.

The Tasks template is supplied with Access.

 3. In the File Name box, type MyTasks.

Tip Naming conventions for Access database files follow those for Windows files. File 
names cannot contain the following characters: \ / : * ? “ < > |. By default, file name 
extensions are hidden, and you shouldn’t type the extension in the File Name box. 
(The extension for an Access 2010 database file is .accdb. For information about this  
file format, which was introduced with Access 2007, search for accdb in Access Help.)
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 4. Click the adjacent Browse button, and then in the File New Database dialog box, 
navigate to your Chapter02 practice file folder.

You use the same navigational techniques in this dialog box that you would use in 
any Open or Save dialog box.

The File New Database dialog box.

 5. With Microsoft Access 2007 Databases selected in the Save as type box, 
click OK.

The path to the specified folder is displayed below the File Name box.

Tip By default, Access creates new databases in your Documents folder. You can change 
the location when you create each database, as you did here, or you can change the 
default save folder. To specify a different default folder, click the File tab to display 
the Backstage view, click Options, and then on the General page of the Access Options 
dialog box, under Creating Databases, click the Browse button to the right of Default 
Database Folder. In the Default Database Path dialog box, browse to the folder you 
want to be the default, and then click OK in each of the open dialog boxes.
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 6. Click the Create button.

Access briefly displays a progress bar, and then the new database opens, with the 
Task List form displayed in Layout view.

Tip Below the form name is a toolbar with commands created by embedded macros. 
These commands are an example of what makes this a database application rather 
than a simple database. The topic of macros is beyond the scope of this book. For 
information, search for macros in Access Help.

 7. If the Navigation pane is closed, click the Shutter Bar Open button at the right 
end of its title bar to open it. Then if any of the groups are collapsed, click their 
chevrons to open them.

The Navigation pane displays a custom Tasks Navigation category.

The custom category has custom Tasks, Contacts, and Supporting Objects groups.

Troubleshooting The appearance of buttons and groups on the ribbon changes depending 
on the width of the program window. For information about changing the appearance of 
the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the 
beginning of this book.
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 8. In the Navigation pane, click the Tasks Navigation title bar, and then in the 
category and group list, click Object Type to list all the objects in this database.

 9. In the Tables group, double-click Contacts.

The empty Contacts table is displayed. You could now start entering data in this 
table.

 10. Right-click the Contacts tab, and click Close All.

 11. On the Create tab of the ribbon, in the Templates group, click the Application 
Parts button.

The Application Parts gallery appears.

The Application Parts gallery.

You can add various types of forms and several sets of related tables and other 
database objects to this or any other database. These ready-made objects give 
you a jump start on creating a fully functional database application.

 12. Click away from the gallery to close it.

 13. Continue exploring the objects that are part of the MyTasks database on 
your own.

CLEAN UP Close the MyTasks database.
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Web Databases

Several of the templates in the Sample Templates gallery and many of the templates 
available from the Microsoft Office Online Web site are designated as Web data-
bases. A Web database is one that is compatible with the new Web publishing 
capabilities of Access 2010. 

If Access Services are installed on your organization’s Microsoft SharePoint server, 
you can now publish a database to Access Services. Publishing converts tables to 
SharePoint lists stored on the server and makes it possible to work with the data-
base either in Access or in a Web browser.

You can create a Web database based on a Web template or build a new one from 
scratch by choosing Blank Web Database on the New page of the Backstage view. 
You can also publish a regular database as a Web database, although the tables in 
the database must conform to Web database requirements for publication to be 
successful. Because of these requirements, if you work for an organization where 
future deployment of Access Services is a possibility, you might want to consider 
creating a Web database to ensure that your database can be published to Access 
Services in the future.

In a Web database, you can create two kinds of objects:

● Web objects These can be created and viewed in either a Web browser 
or Access.

● Non-Web objects These can be created and viewed only in Access.

When you are working with a Web database from a browser, you are working with 
the database on the server. When you are working with it from Access, you are 
working with a local copy of the database that is synchronized with the database 
on the server. For both types of objects, you can make design changes only in 
Access and only when connected to the server.

These days, more and more companies have employees and clients in different 
geographic locations, and more and more people are working away from company 
offices. Web databases make it possible for people to access company databases 
from wherever they are and from any computer, whether or not it has Access 
installed.
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Creating Databases and Tables Manually
Suppose you need to store different types of information for different types of people. 
For example, you might want to maintain information about employees, customers, and 
suppliers. In addition to the standard information—such as names, addresses, and phone 
numbers—you might want to track these other kinds of information:

● Employee identification numbers, hire dates, marital status, deductions, and pay rates

● Customer orders and account status

● Supplier contacts, current order status, and discounts

You could start with a template, add fields for all the different items of information to 
a single Contacts table, and then fill in only the relevant fields for each type of contact. 
However, cramming all this information into one table would soon get pretty messy. It’s 
better to create a new database based on the Blank Database template and then manu-
ally create separate tables for each type of contact: employee, customer, and supplier.

When you create a new blank database or insert a new table into an existing database, 
the table is displayed on a tabbed page in Datasheet view with one empty row that is 
ready to receive data. Because the active object is a table, Access adds the Table Tools 
contextual tabs to the ribbon so that you can work with the table.

A new table in a new database.
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If you close the table at this point, it will disappear, because it contains no data and it has 
no structure. The simplest way to make the table part of the database is to create at least 
one record by entering data, which simultaneously defines the table’s structure.

Tip You can also define the structure of the table without entering data. For information about 
table structure, see “Refining Table Structure” later in this chapter. For information about 
adding new blank fields to a table, see “Restricting the Type of Data” in Chapter 6, “Maintain 
Data Integrity.”

Obviously, to create a record, you need to know how to enter information in Datasheet view.

Primary key

Field waiting for data

Record selector, displaying New icon

The first record in a new table, before data is entered.

Every table has an empty row that is ready to receive a new record, as indicated by the New 
icon (the asterisk) in the record selector at the left end of the row. By default, the first field 
in each new table is an ID field designed to contain an entry that will uniquely identify the 
record. Also by default, this field is designated as the table’s primary key. No two records 
in this table can have the same value in this primary key field. Behind the scenes, the data 
type of this field is set to AutoNumber, so Access will enter a sequential number in this 
field for you.

Tip As you’ll see in a later exercise, the primary key field does not have to be the default 
AutoNumber type. If you need to you create your own primary key field, then anything 
meaningful and unique will work.

See Also For information about data types, see “Refining Table Structure” later in this chapter.

The first field you need to be concerned about is the active field labeled Click To Add. 
You enter the first item of information for the new record in the first cell in this field, 
and then press the Tab or Enter key to move to the first cell in the field to the right. 
Access then assigns the value 1 to the ID field, assigns the name Field1 to the second 
field, and moves the Click To Add label to the third field. The icon in the record selector 
at the left end of the record changes to two dots and a pencil to indicate that this  
record has not yet been saved, and the New icon moves to the record selector of the 
next row. 
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The first record in a new table, after data has been entered in the first field.

When creating a new table in Datasheet view, you need to save the first record after 
entering the first item of data. If you don’t, Access increments the ID value for each field 
you add to that record. For example, if you add seven fields, Access assigns the value 7 to 
the ID field of the first record. To avoid this problem, you simply click the icon in the record 
selector after you enter your first value in the first record. This saves the record with the 
value 1 assigned to the ID field, and subsequent records will be numbered sequentially.

Having entered the first item of data and saved the record, you continue entering items 
of information in consecutive cells and pressing Tab or Enter. When you finish entering the 
last item for the first record, you click anywhere in the row below to tell Access that the 
record is complete.

After you complete the first record of a new table, you will probably want to change the 
default field names to something more meaningful. To rename a field, you simply double-
click its field name and then type the name you want.

At any time while you are entering data in a new table, you can save the table by clicking 
the Save button on the Quick Access Toolbar and naming the table. If you try to close the 
table without explicitly saving it, Access prompts you to save the table. If you click No, 
Access discards the table and any data you have entered.

After you have saved the table for the first time, Access automatically saves each record 
when you move away from it. You don’t have to worry about losing your changes, but you 
do have to remember that most data entries can be undone only by editing the record.

Databases almost always contain more than one table. You can create additional empty 
tables by clicking the Table button in the Tables group on the Create tab of the ribbon. 
If you need to create a table that is similar in structure to an existing one, you can copy 
and paste the existing table to create a new one. When you paste the table, Access gives 
you the option of naming the table and of specifying whether you want the new table to 
have the existing table’s structure or both its structure and its data.
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For some kinds of tables, Access provides Quick Start fields that you can use to add 
common sets of fields or kinds of fields to a table. The Quick Start options take the 
work out of defining these fields and can be very useful when you know exactly what 
type of field you need.

In this exercise, you’ll create a blank database, enter information into the first record of 
its default table, assign field names, add another record, and save and close the table. 
Then you’ll copy that table to create a second one. Finally, you’ll create a new table and 
experiment with Quick Start fields.

SET UP You don’t need any practice files to complete this exercise. Close any open 
databases, and then with the New page of the Backstage view displayed, follow  
the steps.

 1. In the center pane of the New page, in the Available Templates area, click Blank 
Database.

 2. In the right pane, click the File Name box, and type MyTables. Then click the 
Browse button, navigate to your Chapter02 practice file folder, and click OK.

Tip You can’t create a blank database without saving it. If you don’t provide a file name 
and location, Access saves the file with the name Database followed by a sequential 
number in the default location (your Documents folder, unless you have changed it).

 3. In the right pane, click the Create button.

Access creates the blank database in the specified location, opens the database, 
and displays a new blank table named Table1.

 4. With the empty field below Click to Add selected, type Scott, and then press Tab 
to move to the next field.

The icon in the record selector changes to indicate that this record has not yet 
been saved. The value 1 appears in the ID field, the name of the second column 
changes to Field1, and the Click To Add label moves to the third column.

 5. Click the icon in the record selector to save the record before you move on.

Tip Clicking the record selector is necessary only after you enter the first value in a 
new table. This action sets the ID field value to 1.
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 6. Click the cell under Click to Add, and type the following information into the next 
seven cells, pressing Tab after each entry:

 Gode

 612 E. 2nd

 Pocatello

 ID

 73204

 USA

 208 555-0161

As the cursor moves to the next cell, the name of the field in which you just entered 
data changes to Field followed by a sequential number.

The first complete record.

Tip Don’t be concerned if your screen does not look exactly like ours. In this graphic, 
we’ve scrolled the page and adjusted the widths of the columns so that you can see all 
the fields. For information about adjusting columns, see “Manipulating Table Columns 
and Rows” later in this chapter.

 7. Double-click the ID field name (not the ID value in Field5), and then type 
CustomerID to rename it.

Tip Field names can include spaces, but the spaces can affect how queries have to be 
constructed, so it is best not to include them. For readability, capitalize each word and 
then remove the spaces, or use underscores instead of spaces.

 8. Repeat step 7 for the other fields, changing the field names to the following:

Field1 FirstName Field4 City Field7 Country

Field2 LastName Field5 State Field8 Phone

Field3 Street Field6 ZIP

The table now has intuitive field names.
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The renamed fields.

Tip Again, don’t worry if your screen doesn’t look exactly like this graphic, because 
we’ve made adjustments so that you can see all the fields.

 9. Add another record containing the following field values to the table, pressing Tab 
to move from field to field:

FirstName John City Montreal Country Canada

LastName Frederickson State Quebec Phone 514 555-0167

Street 43 rue St. Laurent ZIP (press Tab to skip this field)

 10. At the right end of the tab bar, click the Close button.

 11. When Access asks whether you want to save the design of the table, click Yes.

Important Clicking No will delete the new table and its data from the database.

Access displays the Save As dialog box.

You must save the table before closing it.

 12. In the Table Name box, type Customers, and then click OK.

Access closes the table, which is now listed in the Tables group on the Navigation bar.

The database now contains one table.
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Tip You can rename a table by right-clicking it in the Navigation pane and then clicking 
Rename. You can delete a table by right-clicking it, clicking Delete, and then confirming 
the deletion in the message box that appears. (You can also delete a table by selecting  
it in the Navigation bar and then clicking the Delete button in the Records group on 
the Home tab or pressing the Delete key.)

 13. In the Navigation pane, click the Customers table to select it.

 14. On the Home tab, in the Clipboard group, click the Copy button. Then click the 
Paste button.

Keyboard Shortcut Press Ctrl+C to copy data. Press Ctrl+V to paste data.

See Also For more information about keyboard shortcuts, see “Keyboard Shortcuts” 
at the end of this book.

The Paste Table As dialog box opens.

If you need to create a table that is similar to an existing table, it is sometimes easier  
to customize a copy than to create it from scratch.

 15. In the Table Name box, type Employees. In the Paste Options area, click 
Structure Only to capture the fields from the Customers table but none of 
the customer information. Then click OK.

The new Employees table appears in the Navigation pane.

Tip You can also use the Copy and Paste commands to append the information in the 
selected table to another existing table. In that case, in the Paste Table As dialog box, 
type the name of the destination table in the Table Name box, click Append Data To 
Existing Table, and then click OK.

 16. Double-click Employees to open it in Datasheet view so that you can view its 
fields. Then close the table again.
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 17. On the Create tab, in the Tables group, click the Table button.

Access creates a new table containing an ID field and a Click To Add field 
placeholder.

 18. With the Click to Add field active, on the Fields contextual tab, in the Add & 
Delete group, click the More Fields button.

The More Fields gallery appears.

The Quick Start fields are at the bottom of the More Fields gallery.

 19. If necessary scroll to the bottom of the gallery, and then under Quick Start, 
click Name.

Access inserts ready-made LastName and FirstName fields.

 20. Repeat steps 18 and 19 to add the Address fields from the Quick Start list.

Access inserts ready-made Address, City, State Province, ZIP Postal, and Country 
Region fields.

 21. Close the table, saving it with the name Shippers when prompted.

CLEAN UP Retain the MyTables database for use in later exercises.
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Database Design

In a well-designed database, each item of data is stored only once. If you’re cap-
turing the same information in multiple places, that is a sure sign that you need 
to analyze the data and figure out a way to put the duplicated information in a 
separate table.

For example, an Orders table should not include information about the customer 
placing each order, for two significant reasons. First, if the same customer orders 
more than once, all his or her information has to be repeated for each order, which 
inflates the size of the table and the database. Second, if the customer moves, his 
or her address will need to be updated in the record for every order placed.

The way to avoid this type of problem is to put customer information in a Customers 
table and assign each customer a unique identifier, such as a sequential number or 
unique string of letters, in the primary key field. Then in the Orders table, you can 
identify the customer by the unique ID. If you need to know the name and address 
of the customer who placed a particular order, you can have Access use the unique 
ID to look up that information in the Customers table.

The process of ensuring that a set of information is stored in only one place is 
called normalization. This process tests a database for compliance with a set of 
normalization rules that ask questions such as “If I know the information in the 
primary key field of a record, can I retrieve information from one and only one 
record?” For example, knowing that a customer’s ID is 1002 means you can pull 
the customer’s name and address from the Customers table, whereas knowing  
that a customer’s last name is Jones does not mean that you can pull the cus-
tomer’s name and address from the table, because more than one customer 
might have the last name Jones.

The topic of normalization is beyond the scope of this book. If you need to design 
a database that will contain several tables, you should search for Database 
design basics in Access Help to learn more about the normalization process.
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Manipulating Table Columns and Rows
In Chapter 1, “Explore an Access 2010 Database,” we showed you how to quickly adjust 
the width of table columns to efficiently display their data. In addition to adjusting column 
width, sometimes you might want to rearrange a table’s fields to get a better view of the 
data. For example, if you want to look up a phone number but the names and phone 
numbers are several fields apart, you will have to scroll the page to get the information 
you need. You might want to rearrange or hide a few fields to be able to simultaneously 
see the ones you are interested in.

You can manipulate the columns and rows of an Access table without affecting the under-
lying data in any way. You can size rows and size, hide, move, and freeze columns. You can 
save your table formatting so that the table will look the same the next time you open it, 
or you can discard your changes without saving them.

In this exercise, you’ll open a table and manipulate its columns and rows.

SET UP You need the MyTables database you worked with in the preceding exercise 
to complete this exercise. Open the MyTables database, and then follow the steps.

 1. In the Navigation pane, double-click the Customers table to open it in 
Datasheet view.

 2. In the field name row, point to the right border of the Street field name, and 
when the pointer changes to a double-headed arrow, drag to the right until  
you can see all of the street addresses.

 3. Double-click the right border of any column that seems too wide or too narrow to 
adjust the column to fit its contents.

This technique is particularly useful in a large table where you can’t easily determine 
the length of a field’s longest entry.

 4. Point to the border between any two record selectors, and drag downward.

When you release the mouse button, Access increases the height of all rows  
in the table.

9780735626928_book.indb   61 2/15/11   1:28 PM



62  Chapter 2 Create Databases and Simple Tables

You cannot adjust the height of a single row.

 5. On the Home tab, in the Records group, click the More button, and then click 
Row Height.

The Row Height dialog box opens.

You can set the rows to the precise height you want.

 6. In the Row Height dialog box, select the Standard Height check box, and then 
click OK.

Access resets the height of the rows to the default setting.

 7. Click anywhere in the FirstName field. Then in the Records group, click the More 
button, and click Hide Fields.

The FirstName field disappears, and the fields to its right shift to the left.

Tip If you select several fields before clicking Hide Fields, they all disappear. You can 
select adjacent fields by clicking the field name of the first one, holding down the Shift 
key, and then clicking the field name of the last one. The two fields and any fields in 
between are selected.

 8. To restore the hidden field, in the Records group, click the More button, and then 
click Unhide Fields.
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The Unhide Columns dialog box opens.

You can select and clear check boxes to control which fields are visible.

Tip If you want to hide several columns that are not adjacent, you can display the 
Unhide Columns dialog box and clear their checkboxes.

 9. In the Unhide Columns dialog box, select the FirstName check box, and then 
click Close.

Access redisplays the FirstName field.

 10. If you can see all of the fields in the table, for the purposes of this exercise, adjust 
the size of the program window until some of the fields are no longer visible.

 11. Point to the CustomerID field name, hold down the mouse button, and drag through 
the FirstName and LastName field names. With the three columns selected, click the 
More button in the Records group, and then click Freeze Fields.

 12. Scroll the page to the right until the Phone field is adjacent to the LastName field.

The first three columns remain in view as you scroll.

 13. In the Records group, click More, and then click Unfreeze All Fields to restore the 
fields to their normal condition.

Tip The commands to hide, unhide, freeze, and unfreeze columns are also available 
from the shortcut menu that appears when you right-click a field name.
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 14. Click the Phone field name to select that field. Then drag the field to the left, 
releasing the mouse button when the thick black line appears to the right of the 
LastName field.

 15. Close the Customers table, clicking Yes to save the changes you have made to 
the column widths and order. If you see a warning that this action will clear the 
Clipboard, click Yes.

CLEAN UP Retain the MyTables database for use in later exercises.

Refining Table Structure
Although you can create the structure of a database in Datasheet view, some structural 
refinements can be carried out only in Design view. When you are familiar with tables, 
you might even want to create your tables from scratch in Design view, where you 
have more control over the fields. You can open a new table in Design view by clicking 
the Table Design button in the Tables group on the Create tab.

When you open an existing table in Design view, the tabbed page shows the underlying 
structure of the table.

The table design page.
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This page has two parts. The top part consists of the following:

● Selector You can click the shaded box at the left end of a row to select the entire 
field. You can then insert a row above the selected one, delete the row (thereby 
deleting the field), or drag the row up or down to reposition its field in the table.

The selector also identifies the primary key field of the table by displaying the 
Primary Key icon (a key with a right-pointing arrow).

Tip If you don’t want a table to have a primary key (for example, if none of the fields 
will contain a unique value for every record), select the field designated as the primary 
key, and on the Design contextual tab, in the Tools group, click the Primary Key button 
to toggle it off. If you want to designate a different field as the primary key, select the 
new field, and click the Primary Key button to toggle it on. (You don’t have to remove 
the primary key from the current field first; it will happen automatically.)

● Field Name column This column contains the names you specified when you created 
the table. You can edit the names by using regular text-editing techniques. You can 
add a new field by typing its name in the first empty cell in this column.

● Data Type column This column specifies the type of data that the field can contain. By 
default, the ID field in a new table is assigned the AutoNumber data type, and all other 
fields are assigned the Text data type. With the exception of fields with the OLE Object 
and Attachment data types, you can change the type of any field by clicking its Data 
Type entry, clicking the arrow that appears, and clicking a new data type in the list.

The list of data types.

See also For more information about data types, see “Restricting the Type of Data” in 
Chapter 6, “Maintain Data Integrity.”

● Description column This column contains an optional description of the field.
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The Field Properties area at the bottom of the design page displays the properties of the 
field selected in the top part. Different properties are associated with different data 
types. They can determine such things as the number of characters allowed in a field, 
the value inserted if the user doesn't type an entry, and whether an entry is required. 
Properties can also assess whether an entry is valid and can force the user to select 
from a list of values rather than typing them (with the risk of errors). 

All fields, no matter what their data type, can be assigned a Caption property that will 
appear in the place of the field name in tables or in other database objects. For example, 
you might want to use captions to display the names of fields with spaces, such as First 
Name for the FirstName field.

See Also For information about using properties to control the accuracy of data entry, see 
Chapter 6, “Maintain Data Integrity.” For a comprehensive list of data types and properties, 
search on data types in Access Help.

In this exercise, you’ll open a table in Design view, add and delete fields, change a data 
type, set field sizes, and add a caption.

SET UP You need the MyTables database you worked with in the preceding exercise 
to complete this exercise. Open the MyTables database, and then follow the steps.

 1. In the Navigation pane, right-click the Employees table, and then click Design 
View.

Access opens the table with its structure displayed. Because you created this table 
by copying the Customers table, you need to make some structural changes.

 2. With CustomerID highlighted in the Field Name column, type EmployeeID, and 
then press the Tab key twice.

 3. In the Description column, type Unique identifying number.

 4. Click the Country field’s selector, and then on the Design contextual tab, in the 
Tools group, click the Delete Rows button.

 5. In the empty row below the Phone field, click the Field Name cell, and type 
Birthdate. Then click the Data Type cell.

Access assigns the default Text data type to the new field.

 6. Click the arrow at the right end of the Data Type cell, and in the list, click 
Date/Time.

 7. Repeat steps 5 and 6 to add another Date/Time field named DateHired.
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 8. Select the ZIP field name, change it to PostalCode, and then change its data type 
to Text.

Tip If you use only five-digit ZIP codes, the Number data type is fine. But setting it to 
Text allows you to enter ZIP+4 codes or the letter-number postal codes used in Canada 
and other countries.

The properties in the Field Properties area at the bottom of the design page 
change to those that are appropriate for this type of field.

The properties for the Text data type.

 9. In the box to the right of Field Size, double-click 255, and type 10.

You are specifying that this field can contain no more than 10 characters.

 10. Change the Field Size property of the following fields as shown:

FirstName 50 City 50 Phone 30

LastName 50 State 20

Tip Sometimes changing the field properties of a table that already contains data can 
produce unanticipated results. If you make a change to a field property that might cause 
data to be lost (for example, if you make the Field Size property smaller than one of the 
field’s existing values), Access warns you of this problem when you attempt to save the 
table. For more information, see Chapter 6, “Maintain Data Integrity.”

9780735626928_book.indb   67 2/15/11   1:28 PM



68  Chapter 2 Create Databases and Simple Tables

 11. Click the State field. Then in the Field Properties area, click the Caption box, and 
type State or Region.

The Field Name remains State, but in Datasheet view, the column heading will be 
State or Region.

You have changed the Field Size and Caption properties of the State field.

 12. On the Design tab, in the Views group, click the View button to switch to 
Datasheet view.

Access tells you that you must save the table before leaving Design view.

 13. In the message box, click Yes to save the table.

Access saves the table and displays it in Datasheet view.

 14. With the table displayed in Datasheet view, click the LastName field name. Then 
on the Fields contextual tab, in the Add & Delete group, click the Text button.

A new field called Field1 that has the Text data type is inserted to the right of the 
LastName field.

Tip You can also create a new field with a specific data type by clicking the Click To Add 
label to the right of the last field in the field name row. Then in the list that appears, you 
can click the data type you want.
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 15. With Field1 selected, type Title, and press Enter.

 16. Click the Title field name. Then in the Properties group, in the Field Size box, click 
255 to select it, type 50, and press Enter.

 17. Type the following information in the first record:

FirstName Karen

LastName Berg

Title Owner

The Employees table is now ready for you to start entering data.

The first record of the Employees table.

CLEAN UP Close the Employees table. Retain the MyTables database for use in the 
last exercise.

Creating Relationships Between Tables
In Access, a relationship is an association between common fields in two tables. You can 
use this association to link the primary key field in one table to a field that contains the 
same information in another table. The field in the other table is called the foreign key. 
For example, if customer accounts are assigned to specific sales employees, you can 
establish a relationship by linking the primary key EmployeeID field in the Employees 
table with the foreign key EmployeeID field in the Customers table. Each customer 
account is assigned to only one employee, but each employee can manage many 
customer accounts, so this type of relationship—the most common—is known as  
a one-to-many relationship.

Similarly, if every order is associated with a customer, you can establish a relationship 
by linking the primary key CustomerID field in the Customers table and foreign key 
CustomerID field in the Orders table. Each order is placed by only one customer, but 
each customer can place many orders. So again, this is a one-to-many relationship.
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Less common relationships include:

● One-to-one In this type of relationship, each record in one table can have one and 
only one related record in the other table. This type of relationship isn’t commonly 
used because it is easier to put all the fields in one table. However, you might use 
two related tables instead of one to break up a table with many fields, or to track 
information that applies to only some of the records in the first table.

● Many-to-many This type of relationship is really two one-to-many relationships 
tied together through a third table. You might see this relationship in a database 
that contains Products, Orders, and Order Details tables. The Products table has one 
record for each product, and each product has a unique ProductID. The Orders table 
has one record for each order placed, and each record in it has a unique OrderID. 
However, the Orders table doesn’t specify which products were included in each 
order; that information is in the Order Details table—the table in the middle that 
ties the other two tables together. Products and Orders each have a one-to-many 
relationship with Order Details. Products and Orders therefore have a many-to-
many relationship with each other. In plain language, this means that every product 
can appear in many orders, and every order can include many products.

The most common way of creating a relationship between two tables is to add the 
tables to the Relationships page displayed when you click the Relationships button in 
the Relationships group on the Database Tools tab. You then drag a field in one table 
to the common field in the other table and complete the relationship definition in the 
Edit Relationships dialog box. In this dialog box, you are given the opportunity to im-
pose a restriction called referential integrity on the data, which means that an entry 
will not be allowed in one table unless it already exists in the other table.

After you have created a relationship, you can delete it by deleting the line connecting  
the tables on the Relationships page. You can clear all the boxes from the page by 
clicking the Clear Layout button in the Tools group on the Relationship Tools Design 
contextual tab.
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Tip The coverage of relationships in this topic is deliberately simple. However, relationships 
are what make relational databases tick, and Access provides a number of fairly complex 
mechanisms to ensure the integrity of the data on either end of the relationship. Some of 
these mechanisms are covered in Chapter 6, “Maintain Data Integrity.” For a good overview, 
search for Guide to table relationships in Access Help.

In this exercise, you’ll create relationships between one table and two other tables. 
Then you’ll test the referential integrity of one of the relationships.

SET UP You need the MyTables database you worked with in the preceding exercise 
to complete this exercise. Open the MyTables database, and then follow the steps.

 1. On the Create tab, in the Tables group, click the Table button to create a new 
table.

Before we add fields to this table, let’s save it.

 2. On the Quick Access Toolbar, click the Save button, name the table Orders, and 
click OK.

 3. To the right of Click to Add, click the arrow, and in the data type list, click 
Number. Repeat this step to create a second field with the Number data type.

 4. Double-click Field1, and type CustomerID. Then double-click Field2, and type 
EmployeeID.

Each order in the Orders table will be placed by one customer and will be handled 
by one employee. Let’s create relationships between the Orders table and the 
Customers and Employees tables so that we don’t create records for orders from 
customers who don’t exist or that seem to have been handled by employees who 
don’t exist.

 5. Close the Orders table.

Tip You cannot create a relationship for an open table.

 6. On the Database Tools tab, in the Relationships group, click the Relationships 
button.

The Show Table dialog box opens so that you can indicate the tables for which 
you want to create a relationship.
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The Tables page of the Show Table dialog box.

Troubleshooting If the dialog box doesn’t open automatically, click the Show Table 
button in the Relationships group on the Design contextual tab.

 7. With Customers selected on the Tables page, click Add. Then double-click 
Orders, and click Close.

Access displays the Relationships page and adds a Relationship Tools contextual tab 
to the ribbon.

The two boxes list all the fields in their respective tables.
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 8. In the Customers field list, click CustomerID, and drag it down and over 
CustomerID in the Orders field list, releasing the mouse button when two 
little boxes, one containing a plus sign, appear below the pointer.

The Edit Relationships dialog box opens.

At the bottom of the dialog box, Access indicates that this will be a one-to-many relationship.

 9. Select the Enforce Referential Integrity check box, and then click Create.

Access creates the link between the primary key in the Customers table and the 
foreign key in the Orders table, and a line now connects the two field lists on 
the Relationships page.

The symbols at each end of the line indicate that each Customer ID value appears only once 
in the Customers table but can appear many times in the Orders table.
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 10. On the Design contextual tab, in the Relationships group, click the Show Table 
button. Then in the Show Table dialog box, double-click the Employees table, and 
click Close.

Access adds a box listing all the fields in the Employees table to the Relationships 
page.

 11. On the page, drag the title bars of the three field lists to arrange them so that 
they are side by side and equidistant.

 12. In the Employees field list, click the EmployeeID field, and drag it down and over 
the EmployeeID field in the Orders field list. Then in the Edit Relationships dialog 
box, select the Enforce Referential Integrity check box, and click Create.

 13. After Access draws the relationship line between the primary key and the foreign 
key, close the Relationships page, clicking Yes to save its layout.

 14. Open the Orders table. Then in the CustomerID field of the first record, type 11, 
and click below the record to complete it.

Access displays a message box telling you that you cannot add the new record to 
the table.

The value in the CustomerID field in the Orders table must match a value in the primary key 
CustomerID field in the Customer table.

 15. Click OK. Then change the value to 1, and click below the record to complete it.

This time, Access accepts the value because there is a record with the value 1 in the 
primary key CustomerID field of the Customers table.

CLEAN UP Close the Orders table, and then close the My Tables database.
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Key Points
● Access 2010 includes templates to help you create databases and application parts 

to help you add related tables and other database objects.

● Rather than storing all information in one table, you can create different tables for 
each type of information, such as customers, orders, and suppliers.

● You can create a simple table structure by entering data and naming fields in 
Datasheet view. You can also set the data type and certain properties.

● You can manipulate or hide columns and rows without affecting the data.

● In Design view, you can modify any table, whether you created it manually or as 
part of a template.

● Data types and properties determine what data can be entered in a field, and how 
the data will look on the screen. Caution: changing some properties might affect 
the data.

● You can create a relationship between the primary key field of one table and the 
foreign key field of another so that you can combine information from both tables.
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